
M CertBOIS 116

The

Windows XP

Environment

C E R T I F I C A T E  I N 

B U S I N E S S  O F F I C E 
I N F O R M A T I O N 
S Y S T E M S

Sam
ple

 C
on

ten
t M

ate
ria

l



© 2005 Moustraining Limited
Sentinel House • Modbury

Devon • PL21 0XX
Phone 01548 830710 • Fax 01548 830878

http://www.moustraining.uk.com

Compiled by Alex Hammerstein
Design and layout by Moustraining Limited

Created December 2005
Revision 1.1 March 2006

This material is copyrighted and all rights are reserved. No part of this publication may be reproduced, transmitted, transcribed, 
stored in a retrieval system, or translated into any language or computer language, in any form or by any means, electronic, 

mechanical, magnetic, optical, chemical, manual, or otherwise, without prior written permission.

We make a sincere effort to ensure the accuracy of the material described herein; however, Moustraining Limited makes 
no warranty, expressed or implied, with respect to the quality, correctness, reliability, accuracy, or freedom from error of 
this document or the products it describes. Data used in examples and sample data files are intended to be fictional. Any 

resemblance to real persons or companies is entirely coincidental.

The names of software products referred to in this manual are claimed as trademarks of their respective companies. 

Module reference - MTC116

Certificate in Business Information Systems

Course Team
Professor Ian Chaston - Course Leader

Michelle Rigden - Administrator

Andy Bloomer
Alex Hammerstein
Vicky Hammerstein

Sue Hawker
Paul Mumford
Florise Scully
Trisha Small

Simon Thorpe
Sarah Watson

Tricia Woodgate

Sam
ple

 C
on

ten
t M

ate
ria

l



The Windows Environment

3

T A B L E  O F  C O N T E N T S

TABLE OF CONTENTS ..................................3

INTRODUCTION .........................................5

Chapters ............................................................... 5
Tutorials ................................................................ 5
Chapter Reviews ................................................... 5
Operating System and Graphics used in this 
  module ............................................................... 5
How to Use the Tutorials....................................... 6
Download Module Files ........................................ 6

PERSONAL DEVELOPMENT PLANNING .......7

CHAPTER 1: CUSTOMISING THE TASKBAR 
AND DESKTOP .............................................9

Tutorial 1-1: Using the Windows Classic 
  Start Menu .......................................................... 10
Tutorial 1-2: Using the Windows Classic 
  Appearance ........................................................ 12
Tutorial 1-3: Moving, Resizing and Hiding 
  the Taskbar ......................................................... 14
Tutorial 1-4: Customising the Start Menu .............. 16
Tutorial 1-5: Working with the Quick Launch Bar.. 18
Tutorial 1-6: Opening Recent Documents ............. 20
Tutorial 1-7: Using the Run Command to Start 
  a Programme ...................................................... 22
Tutorial 1-8: Adding Shortcuts to the Desktop ....... 24
Chapter One Review ............................................ 28

CHAPTER 2: CUSTOMISING WINDOWS ....31

Tutorial 2-1: A Look at the Control Panel .............. 32
Tutorial 2-2: Changing the Date and Time ............. 34
Tutorial 2-3: Adjusting the Computer’s Volume ..... 36
Tutorial 2-4: Changing the Colour Scheme 
  and Appearance ................................................. 38
Tutorial 2-5: Adding Wallpaper to the Desktop ..... 40
Tutorial 2-6: Using a Screen Saver ......................... 42
Tutorial 2-7: Changing System and Programme 
  Sounds ............................................................... 44
Tutorial 2-8: Adjusting the Mouse ......................... 46
Tutorial 2-9: Customising How Folders Look 
  and Work ........................................................... 48
Tutorial 2-10: Customising Folder View Options .... 50

Tutorial 2-11: Notepad ......................................... 52
Tutorial 2-12: Calculator ....................................... 53
Tutorial 2-13: Sound Recorder .............................. 54
Tutorial 2-14: Character Map ................................ 55
Chapter Two Review ............................................. 56

CHAPTER 3: OPTIMISING AND 
MAINTAINING YOUR COMPUTER ..............59

Tutorial 3-1: Repairing Disk Errors ......................... 60
Tutorial 3-2: Defragmenting Your Hard Disk .......... 62
Tutorial 3-3: Freeing Up Space on Your 
  Hard Disk ........................................................... 64
Tutorial 3-4: Scheduling Tasks ............................... 66
Tutorial 3-5: Installing New Software ..................... 68
Tutorial 3-6: Removing Software ........................... 70
Tutorial 3-7: Adding and Removing 
  Windows Components ....................................... 72
Tutorial 3-8: Installing a Printer ............................. 74
Tutorial 3-9: Changing Printer Settings and the 
  Default Printer .................................................... 76
Tutorial 3-10: Installing New Hardware ................. 78
Tutorial 3-11: Shutting Down a Frozen 
  Programme ......................................................... 80
Tutorial 3-12: Using Automatic Updates ................ 81
Tutorial 3-14: Using the Device Manager .............. 84
Tutorial 3-15: Using Windows Update .................. 86
Tutorial 3-16: Formatting a Disk ............................ 87
Tutorial 3-17: Copying a Disk................................ 88
Chapter Three Review .......................................... 89

CHAPTER FOUR: PASSWORDS, LOGONS 
& USER ACCOUNTS  ....................................93

Tutorial 4-1: Workgroup vs. Domain ..................... 94
Tutorial 4-2: Creating a New User Account on 
  a Workgroup Computer ...................................... 96
Tutorial 4-3: Creating a New User Account on 
  a Domain Computer ........................................... 98
Tutorial 4-4: Editing a User Account on a 
  Workgroup ......................................................... 100
Tutorial 4-5: Editing a User Account on a 
  Domain .............................................................. 101
Tutorial 4-6: Logging Off Windows on a 
  Workgroup ......................................................... 102
Tutorial 4-7: Logging Off Windows on a 
  Domain .............................................................. 103

Sam
ple

 C
on

ten
t M

ate
ria

l



Cert i f icate in Business  Off ice Informat ion Systems

4

Tutorial 4-8: Logging On to Windows on a 
  Workgroup ......................................................... 104
Tutorial 4-9: Logging On to Windows on a 
  Domain .............................................................. 105
Tutorial 4-10: Changing Your Password on 
  a Workgroup ...................................................... 106
Tutorial 4-11: Changing Your Password on a 
  Domain .............................................................. 107
Tutorial 4-12: Changing the Log On Process 
  on a Workgroup ................................................. 108
Chapter Four Review ............................................ 109

CHAPTER 5: NETWORKING WITH 
WINDOWS XP .............................................111

Tutorial 5-1: Introduction to Networks .................. 112
Tutorial 5-2: Browsing the Network ....................... 114
Tutorial 5-3: Mapping a Network Drive ................. 116
Tutorial 5-4: Connecting to a Network Printer ....... 118
Tutorial 5-5: Sharing Your Files and Printers on 
  the Network ....................................................... 120
Tutorial 5-6: Changing Access Permissions to a 
  Shared Folder ..................................................... 123
Tutorial 5-7: Specifying Security Options in a 
  Folder ................................................................. 126
Tutorial 5-8: A Look at Common Network 
  Hardware ........................................................... 128
Tutorial 5-9: Ethernet Networks ............................ 130
Tutorial 5-10: Installing an Ethernet Home 
  Network ............................................................. 132
Tutorial 5-11: Wireless Networks .......................... 134
Tutorial 5-12: Installing a Wireless Home 
  Network ............................................................. 136
Tutorial 5-13: Connecting to a Wireless Network .. 138
Tutorial 5-14: Connecting to a Wireless 
  Network Manually .............................................. 140
Tutorial 5-15: Automatically Connect to a 
  Wireless Network ............................................... 142
Tutorial 5-16: Basic Network Troubleshooting ....... 144
Tutorial 5-17: Installing a Network Card ................ 146
Tutorial 5-18: Managing Network Protocols 
  and Components ................................................ 148
Tutorial 5-19: Understanding and Configuring 
  TCP/IP ................................................................ 150
Chapter Five Review ............................................. 152

CHAPTER 6: COLLABORATING WITH OTHER 
USERS ..........................................................157

Tutorial 6-1: Planning a Meeting ........................... 158
Tutorial 6-2: Respond to a Meeting Request .......... 160
Tutorial 6-3: Checking Responses to a 
  Meeting Request ................................................. 161
Tutorial 6-4: Creating and Working with 
  Group Schedules ................................................ 162
Tutorial 6-5: Set Free/Busy Options and 
  Publishing Your Calendar on the Internet ............ 164

Tutorial 6-6: Sharing Your Calendar and 
  Other Outlook Folders ........................................ 166
Tutorial 6-7: Opening a Shared Calendar .............. 168
Tutorial 6-8: Giving Delegate Permissions .............. 170
Tutorial 6-9: Open Shared Folders Automatically .. 172
Tutorial 6-10: Assigning Tasks to Another User....... 174
Tutorial 6-11: Working with Public Folders ............ 176
Tutorial 6-12: Adding a New Item to a Public 
  Folder ................................................................. 177
Tutorial 6-13: Replying to Items in a Public 
  Discussion Folder ................................................ 178
Chapter Six Review ............................................... 179

INDEX ..........................................................181

Sam
ple

 C
on

ten
t M

ate
ria

l



The Windows Environment

5

I N T R O D U C T I O N

Welcome to the CertBOIS module: The Windows Environment.  You are probably thinking 
that this is a thick module - well it is, there is a lot of information, but its not too difficult to 
understand!

As with all the CertBOIS course material, the student manuals follow a common format 
and design:

Chapters
Each manual is divided into several chapters.  If you are not sure you’re ready for a 
chapter, you can look at the prerequisites that appear at the beginning of each chapter.  
They will tell you what you should know before you start the chapter

Tutorials
Each chapter contains several Tutorials on related topics.  Each Tutorial explains a new skill 
or topic and contains a step-by-step exercise to give you hands-on experience.

Chapter Reviews
A review is included at the end of each chapter to help you absorb and retain all that you 
have learned. This review contains a brief recap of everything covered in the chapter’s 
tutorials, review questions to assess how much you’ve learned (and which tutorials you 
might want to look over again).  

Operating System and Graphics used in this module
This module has been written based on a computer running the  Windows XP operating 
system.  There are four current versions of Windows operating systems - Windows ME, 
Windows 2000, Windows NT, and Windows XP, itself available in both Home and 
Professional versions.  Sam
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How to Use the Tutorials
Wherever possible, every topic is presented on two facing pages, so that you can 
concentrate on the tutorial without having to worry about turning the page. Since this is a 
hands-on course, each tutorial contains an exercise with step-by-step instructions for you 
to follow.
To make learning easier, every exercise follows certain conventions:

Anything you’re supposed to click, drag, or press appears like this.
Anything you’re supposed to type appears like this.
This book never assumes you know where (or what) something is. The first time you’re 
told to click something, a picture of what you’re supposed to click appears either in 
the margin or in the illustrations at the beginning of the tutorial.
When you see a keyboard instruction like “press <Ctrl> + <B>,” you should press 
and hold the first key (<Ctrl> in this example) while you press the second key (<B> 
in this example). Then, after you’ve pressed both keys, you can release them.
There is usually more than one way to do something. The tutorials explain the 
most common method of doing something, while the alternative methods may be 
mentioned at the end of the tutorial. Use whatever approach feels most comfortable 
for you.
Important terms appear in italics the first time they’re presented.
Whenever something is especially difficult or can easily go wrong, you’ll see a:
NOTE: immediately after the step, warning you of pitfalls that you could encounter if 
you’re not careful.
Our Quick Reference box appears at the end of some tutorials. You can use it to 
review the skills you’ve learned in the tutorial and as a handy reference - when you 
need to know how to do something fast and don’t need to step through the sample 
exercises.

Download Module Files
To help you with the tutorials in this module, we have developed a set of files for you.  
You will need to download these from our web site.  Using an Internet browser, enter 
http://www.moustraining.uk.com/resources or select Student Resource Centre, then Course 
Downloads from the main menu.  Select the Phase 2 modules link and locate MTC116 in 
the list of modules.  You will be able to download the MTC116.exe file by clicking on the 
MTC116 link.

You will be asked if you wish to Open or Save the file, select Save, and choose the folder 
to save the file into.  Once downloaded, browse to that folder, and double-click the file.  It 
will automatically save the files to your c:\certbois\MTC116 folder.

•
•
•

•

•

•
•

•
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P E R S O N A L 

D E V E L O P M E N T 

P L A N N I N G

What is PDP?
Personal Development Planning (PDP) is a 
process of reviewing your academic and non-
academic achievements, reflecting on your 
progress and identifying some targets for your 
future development.
How can PDP help me?
PDP helps you: 

become a more effective, independent 
and confident learner; 
value you own capabilities through 
greater self-awareness;
better understand how you learn and 
how to improve your performance; 
improve your reflective thinking 
skills which can strengthen academic 
performance; 
articulate your skills, personal qualities 
and competences to employers; 
improve your employability;
develop greater self-awareness - what 
you are like, what your strengths and 
weaknesses are, what you want to 
achieve;
make appropriate choices to meet your 
aspirations; 

•

•

•

•

•

•
•

•

To help you to engage in the PDP process 
there are reflective elements built into each 
of your modules.  By completing these and 
considering other aspects of your life where 
you are learning and developing professional 
and transferable skills, you will be able to 
build a portfolio of evidence for your future 
reference and for others.

Module: MTC116 – The Windows 
Environment
This module covers skills in:

Customising the Taskbar and Desktop
Customising Windows
Optimising and Maintaining your 
computer
Passwords, logons and user Accounts
Networking with Windows XP
Collaborating with Other Users

Prior to starting this module take a few 
minutes to think about what you want to gain 
from completing it.  Jot down some notes, 
overleaf, about your success criteria.  In what 
way do you think this achievement will take 
you forward in life?  

•
•
•

•
•
•

 
 How involved are you in your 

own personal development 
planning
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Chapter Objectives:

Defragmenting and fixing errors on your hard disk

Backing up and restoring your hard disk

Freeing up space on your hard disk

Scheduling tasks

Installing and removing software

Adding and removing Windows components

Installing a printer

Installing new hardware

Using the Windows XP update feature

Installing and Reinstalling Windows XP

Using the Device Manager

Cars require maintenance to keep them running at their peak performance. Some car 
maintenance tasks are simple and routine, such as changing oil every 3,000 miles. Others 
are more complicated, such as installing a new radio. Computers are no different. Your 
computer requires routine maintenance to prevent and/or correct problems and to keep it 
running at its best possible performance.

This chapter explains how to optimise and maintain your computer. You’ll learn how to 
find and correct problems on your computer’s hard disk, install and remove software, 
backup and restore your important files, add new hardware to your computer, and more.

•

•

•

•

•

•

•

•

•

•

•

C H A P T E R  3 : 

O P T I M I S I N G  A N D 

M A I N T A I N I N G  Y O U R 

C O M P U T E R

;Prerequisites

How to use the 
mouse to click, 
double-click, 
drag and drop 
and right-click

How to use 
menus, toolbars 
and dialog 
boxes

How to view 
and navigate 
through the 
contents of 
your computer 
(disk drives and 
folders)
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Tutorial 3-1: Repairing Disk Errors  
Over time, errors begin to appear on your computer’s hard drive, thus affecting its 
performance. Fortunately, most of the hard drive damage caused by normal wear and tear 
is not serious and can easily be diagnosed and fixed by a hard drive repair programme      . 
Microsoft Windows XP comes with a hard drive repair programme called Error-checking. In 
this tutorial, you will learn how to use Error-checking to diagnose and repair any errors on 
your computer’s hard disk—a preventative maintenance task that you should do at least 
once a month.

1. Click the Start button and select My Computer from the menu.
Next, you need to right-click the drive you want to check.

2. Right-click the (C:) Local Disk icon and select Properties from the shortcut menu.
The Properties for the selected drive appear in the Local Disk (C:) Properties dialog 
box. Error-checking and several other maintenance tools are located on the Tools tab.

3. Click the Tools tab.
The Tools tab appears, as shown in Figure 3-1. 

4. Click the Check Now button.
The Checking Disk dialog box appears, as shown in Figure 3-2. The (C:) drive is 
selected as the drive to be scanned, because it was the drive you right-clicked. Error-
checking doesn’t have many options, but the ones it does have are important. There 
are two different types of tests you can have Error-checking run: Automatically fix file 
system errors, and Scan for and attempt recovery of bad sectors.

Figure 3-1
The Tools tab of 
the Local Disk 
Properties dialog 
box

Figure 3-2
The Check Disk 
Local Disk dialog 
box
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Automatically fix file system errors: Select the “Automatically fix file system errors” 
check box to have Windows fix disk errors without asking your approval first. If 
you don’t select this check box, Windows XP will prompt you to fix each and 
every error it finds. All files must be closed to run this programme  , and the drive is 
not available to run other tasks while the disk is being checked. If it is in use, you 
will be asked if you want to reschedule the disk checking for the next time you 
start your computer. 

Checking or unchecking the “Scan for and attempt recovery of bad sectors” box does 
one of two things:

Scan for and attempt recovery of bad sectors unchecked: Checks only the files 
and folders on the selected drive(s) for errors. A standard check takes only a 
minute or two to run, and is the computer-equivalent of a 10-point maintenance 
check they do on your car during a routine oil change.
Scan for and attempt recovery of bad sectors checked: Checks the files and 
folders on the selected drive(s) for errors and the surface of the hard drive for 
physical damage. This can take a long time—up to several hours if you have a 
large hard drive. It is the computer-equivalent of an annual vehicle inspection.

5. If you don’t mind waiting a long time, check the Scan for and attempt recovery of 
bad sectors option. Otherwise leave it unchecked.
This will run a thorough test on the (C:) hard drive and will automatically fix any file 
or folder errors. Remember that you cannot have any files from this disk open, or the 
programme cannot begin.

6. Click Start.
The files and folders on the (C:) drive are checked, and its progress is displayed.
NOTE:  Try not to touch Windows while Error-checking is running. No, it won’t hurt 
anything, but any time you make any changes to your computer while Error-checking 
is running, Error-checking starts all over again.
NOTE:  If Error-checking reports any bytes in bad sectors (only available if you 
perform a thorough test), that is not a good sign. Bad sectors are often a sign of an 
imminent hardware failure. Backup everything on the disk immediately, and then run 
a thorough Error-checking test every few days. If more bad sectors appear, the drive 
will likely fail shortly. You shouldn’t continue using disks that have bad sectors.

7. Click OK to close the Results window, and click OK to close the Properties 
window.

That’s all there is to using Error-checking. You can also use Error-checking on floppy disks, 
which are notorious for developing disk errors. If you’re checking a floppy disk, make sure 
you always select the thorough test option.

•

•

•

Turning off your 
computer without 
using the Windows 

XP Shut Down 
sequence is the 
biggest cause of 
hard disk errors.

	 QUICK REFERENCE
To Use Error-checking:

Click the Start button and select My Computer from the menu.
Right-click the disk you want to scan, select Properties from the shortcut menu, and click the Tools tab.
Click the Check Now button.
Specify if you want any errors to be automatically fixed, and if you want to scan for and attempt recovery 
of bad sectors.
Click Start.

•
•
•
•

•

Sam
ple

 C
on

ten
t M

ate
ria

l



Cert i f icate in Business  Off ice Informat ion Systems

62

Tutorial 3-2: Defragmenting Your Hard 
Disk    
Normally, computers store each file in a single location on their hard drive, just like a song 
is recorded on a continuous area of a cassette tape. Over time, however, a hard drive 
can become fragmented, and instead of storing a file in one, single location, it begins 
storing files in pieces, or fragments, in several locations all over the hard drive. When 
the computer reads a fragmented file, it must read the file from several different areas 
of the hard drive instead of just one. Defragmenting a hard drive using a special utility 
programme can improve its performance by putting fragmented files back together in one 
place. Windows XP comes with a disk defragmentation programme called, guess what, 
Disk Defragmenter. You should defragment your computer hard drive about once a month.

Here’s how to defragment your hard drive:

1. Click the Start button and select My Computer from the menu.
Next, you need to right-click the Local Disk drive to defragment it.
NOTE:  Hard drives are really the only type of drive that benefit from running the Disk 
Defragmenter.

2. Right-click the Local Disk (C:) icon and select Properties from the shortcut menu.
The Local Disk (C:) Properties dialog box appears. Defragmentation, and several other 
maintenance tools, are located on the Tools tab of the Properties dialog box.

3. Click the Tools tab.
The Tools tab appears, as shown in Figure 3-3.

4. The Disk Defragmenter dialog appears, advising if the disk needs to be 
defreagmented, as shown in Figure 3-4.  

Figure 3-3
The Tools tab of 
the Local Disk (C:) 
Properties dialog 
box

Figure 3-4
Disk Defragmenter 
reports whether or 
not the disk needs 
to be defragmented
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	 QUICK REFERENCE
To Defragment your Hard Disk:

Click the Start button and select My Computer from the menu.
Right-click the disk you want to defragment, select Properties from the shortcut menu, and click the Tools 
tab.
Click the Defragment Now button.
Click the Analyse button, and click Defragment.

•
•

•
•

5. Click the Defragment Now button.
The Disk Defragmenter appears, as shown in Figure 3-5. Near the bottom of the 
window is a row of buttons you will use to defragment your computer.  

6. Click the Analyse button.
The Defragment programme analyses the selected hard drive and displays the status of 
the hard drive in the “Estimated disk usage before defragmentation” colour bar. 
Eventually a dialog box appears and informs you whether the drive needs to be 
defragmented.

7. Click Defragment if you’re prepared to wait a long time.
The Disk Defragmenter dialog box displays the progress of the defragmentation. 
Defragmenting a hard drive can take a long time - up to several hours - you can 
always run it overnight!
NOTE:  Don’t touch Windows while the hard drive is being defragmented. Just like 
the Error-checking programme, it won’t hurt anything, but any changes you make to 
your hard disk causes Disk Defragmentor to start over.
When the defragmentation is finally complete, a dialog box appears, asking you if you 
want to quit Disk Defragmenter.

8. Click Yes to close the Disk Defragmenter.

9. Other Ways to Start Disk Defragmenter:
Click the Start button and select All Programs → Accessories → System Tools → 
Disk Defragmenter from the menu.

A few final notes on defragmentation: First, you can’t defragment a hard disk that contains 
errors, so it’s usually a good idea to run Error-checking to find and repair errors on your 
hard drive before you defragment it. Second, the Disk Defragmenter programme has been 
optimised in Windows XP. Not only does it defragment your computer’s hard drive, but it 
also places the programmes you use most often at the beginning of the hard drive so they 
start faster.

Figure 3-5
The Disk 
Defragmenter 
dialog box

Sam
ple

 C
on

ten
t M

ate
ria

l



Cert i f icate in Business  Off ice Informat ion Systems

64

Tutorial 3-3: Freeing Up Space on Your 
Hard Disk
As you work at your desk day after day, you create unnecessary paperwork that you 
eventually throw away to free your desk from clutter. Windows does the same thing as 
time passes, except instead of paper, it creates unnecessary files that don’t do anything 
except waste valuable space on your hard disk. The Disk Cleanup utility programme erases 
these rubbish files for you. This tutorial explains how to use the Disk Cleanup utility to 
clear these unnecessary files from your computer.      

1. Click the Start button and select My Computer from the menu.
Next, you need to right-click the Local Disk drive.
NOTE:  The Local Disk drive is the only drive that uses Disk Cleanup.

2. Right-click the Local Disk (C:) icon and select Properties from the shortcut menu. 
Click the General tab.
The Properties for the drive appear, as shown in Figure 3-6.

3. Click the Disk Cleanup button.
Windows analyses the hard disk and determines how many unnecessary files you can 
delete and how much space will be freed by deleting these files. 
After several seconds, the Disk Cleanup dialog box appears and displays this 
information, as shown in Figure 3-7.
The files you can safely delete fall into several categories—see Table 3-1: Types of Files 
you can Delete to Save Space for descriptions of them.

4. Click OK.
Disk Cleanup deletes the selected types of unnecessary files.
That’s all there is to using Disk Cleanup to free space on your hard drive. If you find 
you still need more room on your hard disk, you have several more options. Here are 
some things you can do to reclaim space on your hard disk:

Remove Unnecessary Programmes: One of the best ways to reclaim space on 
your hard disk is to remove old programmes you don’t use. Open Add or Remove 
Programs in the Control Panel to have Windows delete these programmes for you.
Remove Unnecessary Windows Components: Although this won’t free up a lot of 
space, you can remove some Windows components by opening Add or Remove 
Programs in the Control Panel, clicking the Add/Remove Windows 
Components button, and deselecting the components you want to remove.

•

•

Figure 3-6
The General tab of 
the Local Disk (C:) 
Drive Properties 
dialog box

Figure 3-7
The Disk Cleanup 
dialog box
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Table 3-1: Types of Files you can Delete to Save Space 

File Type Description

Downloaded 
Program Files

Similar to Temporary Internet Files, Downloaded Program Files are small programmes 
(ActiveX controls and Java applets if you want to be technical) that have been downloaded 
from the Internet when you view certain pages.

Temporary 
Internet Files

The Internet saves Web pages on your hard disk for quick viewing—so when you return to a 
Web page, it can fetch it much faster from your hard disk than it can from the Internet. This 
collection of files used to speed up the Internet is known as a cache. You can safely remove 
these temporary Internet files from your computer without deleting your Web settings and 
bookmarks or favourite locations. Disk Cleanup does not normally delete these files, since 
they help speed up the Internet.

Office Setup 
Files

To avoid the requirement of inserting a CD whenever you run a Microsoft Office 
programme, the setup files from programme installation may be saved on your computer. 
Deleting these files is not recommended as they help maintain your Office programmes.

Recycle Bin The Recycle Bin contains files you have deleted from your computer. These files are not 
permanently removed until you empty the Recycle Bin.

Temporary Files Programmes sometimes store temporary information in a TEMP folder, usually located in 
the Windows folder. Before a programme closes, it usually deletes this information. Turning 
your computer off without following the Windows shutdown procedure doesn’t give the 
programme or Windows time to cleanup after themselves, and these TMP files are leftover. 
You can almost always safely remove .TMP files.

Temporary 
Offline Files

If you work over a network, copies of files you’ve worked on recently are saved on your 
computer so they can be easily accessed if you are disconnected from the network.

Offline Web 
Pages

Offline pages are Web pages that are stored on your computer so you can view them 
without being connected to the Internet. You can safely remove offline Web pages from 
your computer without deleting your Web settings and bookmarks or favourite locations.

Offline Files Offline files are local copies of network files that you specifically made available.

Compress Old 
Files

Compress (or zip) old files into condensed versions to create more space on the hard drive. 
You can work with a compressed file or folder just as you would an uncompressed file or 
folder.

	 QUICK REFERENCE
To Free Space on Your Hard Disk:

Click the Start button and select My Computer from the menu.
Right-click the hard disk and select Properties from the shortcut menu.
Click the Disk Cleanup button.
Click OK.

•
•
•
•

Sam
ple

 C
on

ten
t M

ate
ria

l



Cert i f icate in Business  Off ice Informat ion Systems

66

Tutorial 3-4: Scheduling Tasks  
To keep your computer in peak condition, you should run maintenance programmes 
regularly. You can have Windows automatically perform these and other tasks on a regular 
basis for you with the Task Scheduler. Task Scheduler will automatically run programmes 
that you tell it to in advance. This tutorial explains how to use the Task Scheduler to run 
programmes on a regular basis.

1. Click the Start button and select All Programs → Accessories → System Tools → 
Scheduled Tasks from the menu.
The Scheduled Tasks window appears, as shown in Figure 3-8.

2. Double-click the Add Scheduled Task icon.
The first screen of the Schedule Tasks Wizard appears.

3. Click Next.
The Scheduled Task Wizard lists all the programmes that are installed on your 
computer. You must select the programme you want to schedule from the list. Error-
checking, Microsoft Backup, Disk Defragmenter and Disk Cleanup are all excellent 
candidates for Scheduled Tasks.
Let’s schedule the Disk Cleanup programme.

4. Select Disk Cleanup from the list and click Next.
Now you need to specify how often you want the selected programme to run, as 
shown in Figure 3-10.

Figure 3-8
The Scheduled 
Tasks window

Figure 3-9
The Scheduled Task 
Wizard lists all the 
programmes on 
your computer—
select the one you 
want to schedule

Figure 3-10
Specify when you 
want the selected 
programme to run
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	 QUICK REFERENCE
To Schedule a Task:

Click the Start button and select All Programs → Accessories → System Tools → Scheduled Tasks from 
the menu.
Double-click the Add Scheduled Task icon. 
Click Next.
Select the program you want to schedule a task for and click Next.
Specify how often you want the program to run and click Next.
Select the time and day when you want the task to occur and click Next.
Enter your user name and password information and click Next.
Click Finish.

To Remove a Task from the Task Scheduler:
Open the Task Scheduler and delete the task, just as you would a file or folder.

1.

2.
3.
4.
5.
6.
7.
8.

•

5. Select Monthly and click Next. 
Now you need to specify the time Task Scheduler should run the selected programme. 
You should always try to schedule a time when the computer won’t be in use, such as 
late at night (so long as you don’t turn off your computer when you’re done with it). 

6. Change the Start time to 3:00 AM. 
NOTE:  The Task Scheduler can obviously only run a programme when your computer 
is turned on, so if you set the time to 3:00 AM you would have to leave your 
computer on overnight (on the first day of each month). Otherwise, set the time to 
one when you know your computer will be switched on.
To change the time, you must first select the hour, minute, or AM/PM. Now choose 
the day you want the programme to run.

7. Select the Day option, as shown in Figure 3-11.
The task will run at 3:00 AM the first day of every month.

8. Click Next.
Now enter your user name and password. This makes the task run under your 
personalised settings.

9. Type your user name and password, confirm the password, and then click Next.
The last screen of the Scheduled Task Wizard appears, reporting that you have 
successfully added a new scheduled task.

10. Click Finish.
The Scheduled Task Wizard closes and the selected programme appears in the 
Scheduled Tasks window.

When you no longer want a programme to be scheduled, just delete it from the Scheduled 
Tasks window—just like you would delete a file.

Figure 3-11
Select the time and 
day you want the 
task to start
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Tutorial 3-5: Installing New Software     
Thanks to the advanced install files and improved operating systems, computer users rarely 
have to do more than click the mouse a few times to install a programme. It’s usually just 
a matter of inserting the program CD, and before you know it, the programme is installed 
on your computer. But if nothing happens after you insert the disk, you may have to start 
things rolling yourself. This tutorial will show you how to install most programmes.

1. Find the programme’s disk (or disks) and insert it (or the first disk) into the disk 
drive.
If your software comes on more than one disk, dig through the box until you find a 
disk labelled Disk 1, Installation, or Setup.
If you’re installing a newer programme from a CD-ROM, you might not have to do 
much more—most CD-ROM’s will automatically start the installation programme 
when the CD is inserted. You can move on to Step 8 if this is the case.

2. Click the Start button and select Control Panel from the menu. Click 
the Add or Remove Programs category and click the Add New Programs 
button on the left side of the window.
The Add or Remove Programs window appears, as shown in Figure 3-12. Here you 
must select where the programme you want to install is located.

3. Click the CD or Floppy button and click Next in the Install Program Wizard.
Windows searches your CD-ROM drive for the program you want to install. Most 
programmes come with a special program called SETUP or INSTALL, which installs the 
main programme onto your computer.

4. Select the Setup or Install file and click Finish.
The install wizard for the programme begins. All you have to do now is follow the 
wizard’s instructions to finish installing the programme.

Figure 3-12
The Add or Remove 
Programs window

Figure 3-13
The Run Installation 
dialog box Sam

ple
 C

on
ten

t M
ate

ria
l



The Windows Environment

69

5. Follow the Install Wizard instructions to finish installing the programme.
The programme should now be installed.
However, if you’re installing a finicky programme, a programme that you’ve 
downloaded from the Internet or a programme located on a network, you’re probably 
going to have to install the programme yourself.
Here’s how to install a programme on your own:  

6. Click the Start button and select My Computer from the menu.
You have to open the disk drive or folder where the setup programme is located. 
For example, double-click the CD-ROM icon if you’re installing from a CD-ROM. If 
you’re installing a programme from a network or that you’ve downloaded from the 
Internet, find and open the folder where the file is saved.

7. Navigate to the location of the programme install file. Double-click the file name 
Setup or Install.
The programme’s install wizard appears.

8. Follow the Install Wizard instructions to finish installing the programme.

The installation process varies between each programme, although most set-ups have more 
similarities than differences. Most programmes use a step-by-step Wizard to guide you 
through the installation process, let you specify where you want to install the programme 
(although they have their own default folder in mind), and let you specify which 
programme components you want to install.

Many installation programmes create their own folder and icons in the Start menu, which 
can be both a blessing and a curse—a blessing because you don’t have to manually add 
an icon to the All Programs menu, and a curse because if you’ve installed a lot of software 
onto your computer, your All Programs menu will be cluttered with dozens of folders and 
programs. You can always reorganise the All Programs menu and reduce the amount of 
clutter.

Most programmes 
have a special 

installation 
programme used 

to install them onto 
your computer. 

These programmes 
are usually named 

Setup, Install or 
something similar.

	 QUICK REFERENCE

To Install Software Using the Control Panel:
Find the programme’s disk (or disks) and insert it 
(or the first disk) into the disk drive.
Click the Start button and select Control Panel 
from the menu.
Click Add or Remove Programs. 
Click Add New Programs.

1.

2.

3.
4.

Click the CD or Floppy button and follow the 
wizard instructions to locate the Setup or Install 
file.

To Install Software Manually:
Open My Computer, find the disk drive or 
folder where the programme you want to install 
is located, and double-click the installation 
programme (usually called SETUP or INSTALL).
Follow the on-screen instructions to install the 
programme.

5.

1.

2.

Figure 3-14
A typical Installation 
screen
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Tutorial 3-6: Removing Software      
You’ve finally finished that adventure game you’ve spent 100 hours on, and since you have 
completed it and no longer need the game, you decide to reclaim the 200 megabytes it 
occupies on your hard drive. So how do you remove, or delete, a programme that you no 
longer need from Windows? You’ll learn how in this tutorial.

Before Windows 95, removing programmes from the computer was a very messy 
process—so messy, in fact, that most people never removed programmes they no longer 
needed. They just sat there, taking up valuable space on the hard drive. Times have 
changed, and removing most programmes is a breeze with Windows XP. The following 
steps should remove all but the most obsolete programmes from your computer.

1. Click the Start button and select Control Panel from the menu. Click the Add or 
Remove Programs category.
The Add or Remove Programs dialog box appears with a list of all the programmes on 
your computer, as shown in Figure 3-15. 

Most of the programmes installed on your computer should appear on this list, in 
alphabetical order.

2. Select the programme you want to remove from your computer, and click the 
Remove button.
Be absolutely sure you want to remove the programme, as it will be completely 
erased from your hard disk. If you created any files or documents with the programme 
that you’re removing, it’s probably a good idea to back them up, but removing a 
programme usually doesn’t affect any files it created.

3. Click Yes to confirm the   programme’s removal, and finish removing the 
programme by following the on-screen instructions.

Figure 3-15
The Change or 
Remove Programs 
view of the Add or 
Remove Programs 
dialog box

Figure 3-16
The Confirm File 
Deletion dialog box
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	 QUICK REFERENCE
To Remove a Programme:

Click the Start button and select Control Panel from the menu.
Click the Add or Remove Programs category.
Select the programme you want to remove from your computer and click the Remove button.
Click Yes to confirm the programme’s removal and finish removing the selected programme by following 
the on-screen instructions.

1.
2.
3.
4.

Since every programme is different, the steps for removing a programme may differ slightly 
as well. The steps basically confirm that you want to delete the programme and may 
ask you to specify which components of a programme you want to delete. You may also 
have to restart your computer. After following the prompts and instructions, the selected 
programme is deleted from your computer. Of course, you can always reinstall the 
programme should you ever decide you need it again.

What if the programme I want to remove doesn’t appear in the list? Sorry, but there is no 
easy way to remove this type of programme. The programme was probably written for an 
older version of Windows, or even MS-DOS, and cannot be automatically removed by 
Windows. There are still several things you can try to remove the programme:

Firstly, check the menu group where the programme is located in the Start menu. 
Usually there are several additional menus or icons. If one of the options says something 
like “Uninstall Software,” you’re in luck—you can click that option and remove the 
programme. 

Secondly, you can purchase and install an uninstall programme to remove the programme. 
Uninstall programmes are great for removing older Windows programmes and they’re 
usually safe to use. The disadvantage is that you have to buy them. Before rushing out to 
your computer shop, consider the number of programmes you need to remove from your 
computer. If it is only one or two, then the prospect of paying £20 or £30 for an Uninstall 
programme isn’t very appealing.

Thirdly, you can try deleting the programme the old-fashioned way—by opening My 
Computer or Windows Explorer and finding and deleting the folder where the programme 
is located. Be very careful and make sure you know what you’re doing when you remove 
or delete the programme yourself—you don’t want to delete something that shouldn’t be 
deleted!
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Tutorial 3-7: Adding and Removing 
Windows Components
Windows XP is normally not installed with all the components that come on the Windows 
XP CD. This prevents programmes you don’t need from taking up hard disk space on the 
computer. For example, if your computer doesn’t have a modem, it doesn’t make much 
sense to install any communication components. So what are these optional Windows 
components? Take a look at Table 3-2: Windows Components. This tutorial will show you 
how you can add and remove these optional Windows components to and from your 
computer.
 

1. Click the Start button and select Control Panel from the menu. Click the Add or 
Remove Programs category and click the Add/Remove Windows Components 
button.
The Windows Components Wizard appears, as shown in Figure 3-17. You can 
view which components have been installed and which haven’t by looking at the 
Components list.

The Windows components are grouped by category. An unchecked box beside a 
category indicates none of its components have been installed. A checked box beside 
a category means all of its components have been installed. A shaded check box 
beside a category means some of its components have been installed. 
To view which components are in a category, select the category and click the Details 
button.

2. Scroll down the Components list to view all the components to choose from. Click 
the Accessories and Utilities category (the word, not the checkbox) to select it, 
and click the Details button.
The details of the Accessories and Utilities category appear in their own dialog box, as 
shown in Figure 3-18. 

3. Click the Games category. Click the Details button.
Games installed on the computer are checked. To remove a Windows component, 
simply remove the check mark from a check box.

4. Click the Internet Games check box to uncheck it.
This component allows you to play the Windows games with other users over the 
Internet.

5. Click OK in the Games dialog box, and click OK in the Accessories and Utilities 
dialog box.
You have returned to the Windows Components Wizard window.
It’s not recommended, but you can also remove an entire category by clicking its 
check box. Let’s just remove the game component for now.

Figure 3-17
The Windows 
Components 
Wizard

Figure 3-18
Details of the 
Accessories and 
Utilities component 
category
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6. Click Next.
Windows identifies the component changes.

7. Click Finish.
The Internet Games component is removed from the computer.
Remember, if you remove a component, you can always go back and click the check 
box to add the component again. But to add a component, you may need to have the 
Windows XP CD-ROM on hand. 

Table 3-2: Windows Components

Components Description

Accessories and Utilities Install a variety of accessories, including games, small applications, and wallpaper. 

Fax Services Allows faxes to be sent and received.

Indexing Service Locates, indexes, and updates documents to provide fast full-text searching.

Internet Explorer Adds or removes access to Internet Explorer from the Start menu and Desktop.

Internet Information 
Services (IIS)

Includes Web and FTP support, along with support for FrontPage, transactions, 
Active Server Pages, and database connections.

Management and 
Monitoring Tools

Includes tools for monitoring and improving network performance.

Message Queuing Programmes for playing sounds, animation, and video on your computer. Also adds 
additional sound effects.

Online Services Provides guaranteed message delivery, efficient routing, security, and transactional 
support.

MSN Explorer Explore the web, read your e-mail, talk to your online buddies, enjoy online music 
and video, and more.

Networking Services Contains a variety of specialised, network related services and protocols.

Other Network File and 
Print Services

Shares files and printers on this computer with others on the network.

Outlook Express E-mail client that allows you to send and receive e-mail messages.

Update Root Certificates Automatically downloads the most current root certificates for secure e-mail, WEB 
browsing, and software delivery.

Windows Media Player Plays media files, such as music and video.

Windows Messenger Allows you to chat with your instant messenger contacts.

	 QUICK REFERENCE
To Add or Remove Windows Components:

Click the Start button and select Control Panel 
from the menu. 
Click the Add or Remove Programs category.
Click the Add/Remove Windows Components 
button.
Click the box beside the component category 
you want to add (;) or remove (�).

1.

2.
3.

4.

Click Next.
Click Finish.

To Add or Remove a Windows Component in a 
Category:

Select the category, click Details, and then click 
the box beside the component category you 
want to add (;) or remove (�). 
Click OK.

5.
6.

1.

2.
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Tutorial 3-8: Installing a Printer     
Want to add a printer to your computer? Before you can use it you need to install it 
on your computer. This tutorial will show you how to install a printer attached to your 
computer.

1. If at all possible, install the printer using the included software and 
documentation.
Hopefully that’s all you will have to do and you can skip the remaining steps in this 
tutorial! If you can’t find the software and/or documentation, read on…

2. Place the printer near your computer and plug the printer cable into your 
computer’s USB or parallel port. Turn your computer and the printer on.
Most printers connect to the USB port at the back of your computer, but there are 
still some printers that connect to the older, much larger, parallel port. Usually, the 
computer detects the new printer and will automatically begin installing the printer. If 
for some reason this doesn’t happen, read on.

3. Click the Start button and select Control Panel from the menu. Click the Printers 
and Other Hardware category.
The Printers and Other Hardware window appears, as shown in Figure 3-19.

4. Click the Add a printer task.
The first page of the Add Printer Wizard springs onto your screen. 
The Add Printer Wizard will help you setup your printer by walking you step-by-step 
through the entire installation process.

5. Click Next.
The Add Printer Wizard may ask how the printer is connected to the computer: 
locally or over a network. A local printer plugs directly into your computer; a network 
printer is located elsewhere on the network.

6. Select the Local option.
You can skip ahead by clicking the “Automatically detect and install my Plug and Play 
printer” check box, which attempts to install the printer for you.

7. Click Next.
Here you need to specify the port you want to use.

8. Select the port that your computer uses from the drop down list.
If you don’t see your port in the list (a common problem if you’re using a USB printer) 
you will probably need to install the printer using the software that came with it. If you 
don’t have the software, try downloading it from the manufacturer’s Web site.

Figure 3-19
The XP Home 
Printers and Other 
Hardware window

Figure 3-20
Selecting a printer 
port (LPT1 and 
USB are the most 
common ports)

USB Port

Parallel Port
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9. Click the manufacturer of your printer from the manufacturer list.
You may have to scroll down the list. When you click on the manufacturer’s name, a 
list of printer models from that manufacturer appears in the model list to the right.

10. Click the model of your printer in the model list.   
If you can’t find your printer in the list, insert the installation disk that came with your 
computer and click the Have Disk button. You may have to refer to the instructions 
that came with your printer to install it.

11. Click Next.
Give the printer a name in the Printer Name box. You must also decide if you want 
to use the printer being installed as the default. The default printer is where Windows 
prints all of its files, unless you specify otherwise.

12. Enter a printer name. Click the Yes option to set the default printer.
The Add Printer Wizard assigns a name to the printer and sets it as the computer’s 
default printer.

13. Click Next.
Specify if this printer will be shared by others. If your computer is not part of a 
network you won’t be sharing the printer. 

14. Click Next.
Windows asks if you would like to print a test page to make sure your new printer 
works. This is a good way to verify that your printer is working properly. 

15. Click Yes to print a test page and click Next.
Finally, your printer is almost complete.

That’s it—your printer is installed and should appear as a new icon in the Printers folder. 
Don’t forget to see if your test page printed successfully.

Select the printer model.

Select the printer 
Manufacturer

If your printer 
isn’t in the 
list, insert the 
installation disk 
that came with 
the printer and 
click Have Disk.

Figure 3-21
Selecting a printer 
driver by make and 
model

	 QUICK REFERENCE
To Install a New Printer:

If at possible, install the printer using the included 
software and documentation.
Click the Start button and select Control Panel 
from the menu. 
Click the Printers and Other Hardware category.
Click the Add a printer task. Click Next.
Specify how the printer is connected (local or 
network). Click Next.
Select a port to use with the printer. Click Next.

1.

2.

3.
4.
5.

6.

Select the printer’s manufacturer and model. 
If your printer doesn’t appear in the list, insert 
the disk that came with the printer and click the 
Have Disk button. Click Next.
(Optional) Assign a name to the printer and set 
the printer as the default. Click Next.
Specify if the printer will be shared and click 
Next.
Specify if you want a test page printed and click 
Next.
Click Finish.

7.

8.

9.

10.

11.
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Tutorial 3-9: Changing Printer Settings 
and the Default Printer   

Sometimes you may want to tweak the settings on your printer. For example, perhaps you 
have more than one printer connected to your computer and want to change the default 
printer. Maybe you want to take advantage of some of your printer’s more advanced 
features or are having trouble printing and want to look at your printer’s settings to find out 
what’s wrong. This tutorial will show you how to change which printer your computer uses 
as the default printer (where your computer prints everything unless you specify otherwise) 
and how to view and change the default settings for your printer.

1. Click the Start button and select Control Panel from the menu.
The Control Panel appears. 

2. Click the Printers and Other Hardware category and click Printers and Faxes.
The Printers and Faxes window appears.

3. Right-click the printer you want to set as the default printer and select Set as 
Default Printer from the shortcut menu.
The default printer displays a black checkmark (). Any documents you print will be 
sent to the default printer.
You can also view the properties for your printers. Here’s how:

4. Right-click the printer and select Properties from the shortcut menu.
The Properties dialog box for your particular printer appears, as shown in Figure 3-24. 
Keep in mind that every printer is different, so the Properties dialog box for your 
printer may look a lot different from the one shown in Figure 3-24. All Printer 

Figure 3-22
Assigning a name 
to the printer and 
designating the 
default printer

Figure 3-23
Right-click any 
printer in the 
Printers folder to 
change its settings
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Properties dialog boxes let you change the default options for your particular printer—
what port it uses, its print quality, etc.

5. Click Cancel to close the Properties dialog box, then close the Printers folder.

Clicking a tab lets 
you view and change 
those settings for your 
printer 

	 QUICK REFERENCE
To Change the Default Printer:

Click the Start button and select Control Panel from the menu.
Click the Printers and Other Hardware category and click Printers and Faxes.
Right-click the desired printer and select Set as Default Printer. 
To View or Change a Printer’s Properties:Right-click the printer and select Properties.

1.
2.
3.
4.

Figure 3-24
The printer 
Properties dialog 
box will be different 
for every printer, 
depending on the 
printer’s features
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Tutorial 3-10: Installing New Hardware   
Anytime you add a new hardware gadget such as a printer or scanner to your computer, 
you need to make sure Windows XP can talk with and operate it. Windows communicates 
to your computer’s hardware components using a small piece of software called a driver. 
A driver is like a computerised operating manual that tells Windows how to communicate 
and operate all the hardware devices in your computer.

Whenever you install a new piece of hardware to your computer, such as a network card 
or a removable storage device, you need to install the driver for that particular piece of 
hardware. If you’re lucky, the piece of hardware is a Plug and Play device. Plug and Play 
devices are devices that Windows can automatically detect and set up to work with your 
computer, making them a breeze to install. Most new devices are Plug and Play. 
If the device doesn’t automatically install, you’ll have to get things going yourself. This 
tutorial will help you install a hardware device either way.

1. Plug in the hardware device to your computer.
Your computer can be on or off when you plug in the device, although the computer 
will have an easier time detecting the device if you plug it in before you turn on the 
computer.

2. If Windows XP detects the device, the Found New Hardware icon will appear in 
the left of the desktop window, followed by the Found New Hardware Wizard. 
Follow the on-screen instructions.
Make sure you have the disk or CD-ROM that came with your new hardware device 
and the Windows XP CD-ROM handy—Windows will probably ask you for them. 
If Windows XP doesn’t automatically detect your new hardware, try installing the 
hardware yourself.

Figure 3-25
The Add Hardware 
Wizard

Figure 3-26
The Add Hardware 
Wizard searches for 
new hardware

Figure 3-27
Windows displays 
the detected 
hardware

Found New 
Hardware icon
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3. Click the Start button and select Control Panel from the menu. Click the 
Performance and Maintenance category.
The Performance and Maintenance category of the Control Panel appears.

4. Click System.
The System Properties dialog box appears.   

5. Click the Hardware tab and click the Add Hardware Wizard button.
The first screen of the Add Hardware Wizard appears.

6. Click Next and follow the on-screen instructions to install the new hardware.
First, Windows looks for new Plug and Play devices on your computer. If it finds any, 
you will probably be asked to insert the disk or CD-ROM that came with your new 
hardware device.
Next, Windows searches for hardware that is not Plug and Play compatible, which 
may take a long time. If it finds any, you will be asked to insert the disk or CD-ROM 
that came with your new hardware device.

If you’ve followed the above steps and Windows still can’t find your new device, or if 
the device doesn’t work after you’ve installed it, bad news—you might have a hardware 
conflict. Some hardware devices require resources on your computer. These resources are 
as technical as they sound—IRQs, DMA channels, and I/O ports. All you need to know 
about them is that there is a limited number of them on your computer (for example, most 
computers have only one or two available IRQs), and, for the most part, several hardware 
components can’t share the same resource. For example, if you were trying to install a 
modem that uses IRQ 3 and your network card is already using IRQ 3, the modem isn’t 
going to work.

So what’s the solution? You can change the resource settings for most devices—either 
through Windows or by moving some pins or switches on the hardware device itself (refer 
to the hardware’s user manual for how to do this).

	 QUICK REFERENCE
To Add New Hardware to Your Computer:

Plug in the hardware device to your computer. (Windows should automatically detect and install the 
device for you. If not, go on to the next step).
If Windows doesn’t recognise the new hardware, click the Start button and select Control Panel from the 
menu.
Click the Performance and Maintenance category and click System.
Click the Hardware tab and click the Add Hardware Wizard button.
Click Next and follow the on-screen instructions to search for your new hardware.

1.

2.

3.
4.
5.
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Tutorial 3-11: Shutting Down a Frozen 
Programme    
Sooner or later you’re going to discover that computers don’t always work the way they’re 
supposed to. Nothing is more frustrating than when a programme, for no apparent 
reason, decides to take a quick nap, locks up, and stops responding to your commands. 
There’s usually no way to restore a frozen application, but you can usually shut down the 
misbehaving programme without having to restart your computer.

1. Start the WordPad programme.
The WordPad programme appears on the screen. Imagine that you’ve just finished 
writing a letter in WordPad. Like a good Windows user, you save your file, and then 
click the Print button to send the document to the printer. Nothing. Not only does the 
document fail to print, WordPad decides to go on strike and stops responding to your 
commands.
When a programme freezes, there’s nothing you can do except dump the programme 
from your computer’s memory (hopefully you’ve been periodically saving whatever 
you’ve been working on so you won’t lose too much of your work, or if it’s a Microsoft 
Office 2003 program you can use the AutoRecovery feature). The next step will show 
you how to forcefully close a programme.

2. Press <Ctrl> + <Alt> + <Delete>.
The Windows Task Manager window appears, as shown in Figure 3-28. 
All the programmes that are running are listed. Any programmes that are frozen or 
locked up will have a “(Not responding)” message after them. WordPad hasn’t stopped 
responding, but for the sake of this tutorial we’ll pretend it has.

3. Select WordPad and click End Task.
Windows forcibly closes the WordPad programme. 

Sometimes a programme may cause your entire computer to lock-up, and even pressing 
<Ctrl> + <Alt> + <Delete> won’t do anything. What should you do when this 
happens? There is only one thing you can do—turn your computer off, and restart it.

Figure 3-28
The Windows Task 
Manager window

	 QUICK REFERENCE
To Shut Down a Frozen Programme:

Press <Ctrl> + <Alt> + <Delete>. 
Select the program and click End Task.

1.
2.
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Tutorial 3-12: Using Automatic Updates    
When a manufacturer finds a problem in a product they have made, they call back the 
product for repairs or to replace it. Microsoft does a similar thing with Windows: when 
a security vulnerability is found, Microsoft creates a patch to repair the problem.   You 
don’t have to bring your computer into a repair shop or send it back to Microsoft, 
because Automatic Updates downloads critical repairs and updates that are essential for a 
functional computer onto your computer over the Internet.

1. Click the Start button and select Control Panel from the menu.
The Control Panel appears.

2. Click the Security Center category and click Automatic Updates.
The Automatic Updates dialog box appears, as shown in Figure 3-29. 
The options to change Automatic Updates are described in the table below.

Table 3-3: Automatic Update Settings

Setting Description

Automatic (recommended) Updates are downloaded and installed automatically every day at 3:00 
AM. The schedule for checking updates can be changed.

Download updates for me, but let 
me choose when to install them.

Updates are downloaded but not installed. An icon in the system tray 
notifies that updates are ready to be installed.

Notify me but don’t automatically 
download or install them.

When updates are available, an icon in the system tray notifies you that 
updates are available at the Microsoft Web site.

Turn off Automatic Updates. All responsibility to keep your computer up to date is yours.

Figure 3-29
The Automatic 
Updates dialog box

Windows XP 
Service Pack 2 is 
an update that is 
installed on your 

computer through 
Automatic Updates.

An Internet 
connection is 

required to use 
Automatic Updates.

	 QUICK REFERENCE
To Run Automatic Updates:

Click the Start button and select Control Panel from the menu.
Click the Security Center category.
Click Automatic Updates.

1.
2.
3.
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Tutorial 3:13: Restoring Your Computer 

If you are experiencing problems with your computer, you can use Windows XP’s System 
Restore utility to return your computer configuration to a time before the problems 
occurred. For example, perhaps your computer doesn’t work properly after you installed 
a bad discount software programme. You can use System Restore to return your computer 
configuration back to the way it was before you installed that programme, without losing 
recent work, such as e-mail, documents, or history and favourites lists.

System Restore keeps track of the changes you make to your computer at specific intervals 
and when you install new hardware and software programmes. You can also create your 
own restore points to record your computer settings at any given time, in case you want to 
return your computer to that state later.

In this tutorial you will learn how to use System Restore.

1. Click the Start button and select All Programs → Accessories → System Tools → 
System Restore from the menu.
The Welcome to System Restore window appears. You can select one of two options:

Restore my computer to an earlier time: This option lets you undo the changes 
made to your computer by selecting a restore point on a calendar. 
Create a restore point: Windows XP automatically creates restore points, but 
you can also create your own restore points manually by selecting this option. 
This is useful if you are about to make a major change to your computer, such as 
installing a new program or new hardware.

Since Windows XP automatically creates restore points for you, most of the time you 
will select the first option.

2. Make sure the Restore my computer to an earlier time option is selected and click 
Next.
The Select a Restore Point window appears, as shown in Figure 3-30. 
The calendar displays the current month and the days for which restore points are 
available. Each day with a restore point appears in bold. 
The right side of the window displays the restore points that are available for the 
selected day (if you were making a lot of system changes to your computer, there may 
be more than one).

•

•

Figure 3-30
The new System 
Restore programme 
can return 
your computer 
configuration to 
a time before the 
problems occurred
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3. Select the restore point nearest to the time when your computer was working 
properly. Click Next.
The next screen appears, asking you to close all open files and programmes before 
restoring your computer.

4. Close all open programmes. Click Next.
System Restore returns your computer to the selected restore point configuration. 
When it’s finished, your computer will automatically restart.
After your computer restarts, you will be greeted by the System Restore window and a 
message indicating that your computer has been restored to a previous state.

5. Click OK to close the System Restore window.

You can also use System Restore to reverse the changes made when you restored your 
computer. To undo any restoration, simply repeat Step 1, select the “Undo my last 
restoration” option in Step 2, and follow the on-screen instructions.

Please note that System Restore does not replace the process of uninstalling a programme. 
To completely remove the files installed by a programme, you must remove the 
programme using Add/Remove Programs in the Control Panel or the programme’s own 
uninstall programme.
  

	 QUICK REFERENCE
To Restore your Computer:

Click the Start button and select All Programs → Accessories → System Tools → System Restore from 
the menu.
Make sure the Restore my computer to an earlier time option is selected. Click Next.
Select the restore point nearest to the time when your computer was working properly. Click Next.
Close all open files and programs. Click Next.
When the restore is complete the computer automatically restarts.
Click OK to close the System Restore window.

To Create a Restore Point:
Click the Start button and select All Programs → Accessories → System Tools → System Restore from 
the menu.
Select Create a restore point. Click Next.
Enter a name for your restore point. Click Create.
Click Close to close the System Restore window.

1.

2.
3.
4.
5.
6.

1.

2.
3.
4.
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Tutorial 3-14: Using the Device Manager     
The Device Manager lets you:

View information about your computer’s hardware.
Remove hardware device drivers.
Change the computer resources a device uses.

If you’re trying to install a new hardware device, have carefully followed the instructions 
that came with the device and the device still doesn’t function, there may be one of two 
problems: 

The device is defective and you’ll need to get another one, or… 
You have a resource conflict. Most hardware devices require resources on your 
computer. These resources include Interrupt Requests (IRQs), Direct Memory Access 
(DMA) channels, and Input/Outputs (I/Os). You don’t have to know what these 
resources mean from a technical standpoint, but it is important that you realise that 
because these resources are limited, your computer may not be able to accommodate 
very many hardware components.

The most common type of resource conflict is an Interrupt Request (IRQ) conflict, which 
occurs when there aren’t enough IRQs available. For example, if you were trying to install 
a modem that uses IRQ 3 and your network card is already using IRQ 3, the modem isn’t 
going to work.

So what’s the solution? You can change the resource settings for many devices, either by 
using the Device Manager or by moving some pins or switches on the hardware device 
itself (refer to the hardware’s user manual for how to do this).
This tutorial will introduce you to the Device Manager so you can see the hardware 
devices that are installed on your computer, and how to configure or remove them.

1. Click the Start button and select Control Panel from the menu. Click the 
Performance and Maintenance category.
The Performance and Maintenance category of the Control Panel appears.

2. Click System.
The System Properties dialog box appears. 

3. Click the Hardware tab and click the Device Manager button.
The Device Manager displays your computer’s hardware in hierarchical order. 

•
•
•

•
•

Figure 3-31
The Hardware 
tab of the System 
Properties dialog 
box

Figure 3-32
The Device 
Manager lists all the 
hardware devices 
installed on your 
computer

Warning!
Be extra careful 
when you use 

the Device 
Manager. You 

can cause serious 
problems if you 

accidentally remove 
or incorrectly 

configure a device.
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4. Click the Computer plus symbol to expand the category.
Right-click a hardware device to display its properties.

5. Right-click the Network Connection device and select Properties from the shortcut 
menu.
Here you can see which hardware devices are using which resources.
Most hardware devices have two or three tabs in the Properties dialog box. They are:

General: Displays the status of the hardware and allows you to disable it.
Driver: Displays details about the device driver and allows you to update the 
driver (provided you have a newer driver).
Resources: Displays the resource currently used by the hardware. It’s almost 
always best to let Windows manage a device’s resources automatically. Only 
manually change a device’s resources if instructed by the hardware manual or 
technical support. 

6. Click the Close button and close all open windows to end the tutorial.

 Table 3-4: Symbols You’ll See in the Device Manager

Symbol Description

Unknown Device
The device doesn’t have any drivers installed, and therefore your computer can’t use it. 
You’ll have to install drivers for the device—see the tutorial on installing hardware.

Device Problem
The device has a problem. This can be caused by a resource conflict (the device is trying to 
use a resource on your computer that’s already in use), an incorrect driver, or a hardware 
failure. The type of problem will be displayed in the properties for the hardware.

•
•

•

	 QUICK REFERENCE
To Open the Device Manager:

Click the Start button and select Control Panel from the menu.
Click the Performance and Maintenance category and click System. 
Click the Hardware tab and click the Device Manager button.

To View or Change a Device’s Properties:
Right-click the device and select Properties from the shortcut menu.

To Remove a Device Driver:
Select the device and click the Uninstall button on the toolbar.

Be VERY CAREFUL when using the Device Manager! Don’t remove a hardware device or change its settings 
unless you know what you’re doing.

1.
2.
3.

•

•

Figure 3-33
The Resources tab 
lets you change 
the resources a 
particular device 
uses
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Tutorial 3-15: Using Windows Update   
Keeping your computer up to date is important. If you don’t rely on Automatic Updates to 
do this for you, you are responsible for downloading updates through Windows Update. 
Windows Update allows you to download critical updates, but it includes more fun 
updates, like a new Windows Media Player or desktop themes.

1. Click the Start button and select All Programs → Windows Update from the menu.
The Microsoft Windows Update Web page appears with two options:

Express Install: This option installs the same updates as Automatic Updates. 
Includes critical and security updates necessary for your computer to work 
properly.
Custom Install: In addition to critical and security updates, you can install and 
review optional updates, such as new desktop themes.

2. Click the type of install you want to perform.
Windows Update scans your computer to see which updates are available for your 
computer. When the scan is complete, go ahead and install your updates.

3. If you selected Express Install, click the Install button. If you selected Custom 
Install, click the check box next to the updates you want to install. Click Go to 
install updates to install the updates.

The Windows Update service downloads and installs the files you selected. Since you’re on 
the Internet, this can take some time, depending on how many files you selected and how 
fast your connection to the Internet is. You may have to restart your computer when the 
download is complete, depending on the changes that have been made to your computer.

Windows XP Service Pack 2: Windows Update now includes security patches and updates 
for Microsoft applications, including SQL, Exchange, and Office, in addition to updates 
for Windows XP.  Windows Update itself has changed, so you may be asked to update 
Windows Update before adding other updates. 

•

•

Figure 3-34
The Microsoft 
Windows Update 
Web page

	 QUICK REFERENCE
To Use Windows Update:

Establish a connection to the Internet.
Click the Start button and select All Programs → Windows Update from the menu.
Click the type of install you want to perform.
Express Install: Click the Install button.
Custom Install: Click the check box next to the updates you want to install. Click Go to install updates to 
install them.

1.
2.
3.
4.
5.
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Tutorial 3-16: Formatting a Disk    
Before you can use a disk, you must format it so that you can save information on it. You 
can also format a disk to erase any files that are saved on it and prepare it for new files. 
You can save yourself a lot of time by buying pre-formatted disks—just make sure they are 
formatted in IBM format!

It’s true that this type of disk is almost obsolete; some new computers don’t even have this 
type of drive installed. But you may still find a need for them when installing drivers and 
USB ports. Here’s how to format a disk:

1. Insert the disk you want to format into the drive.
NOTE:  Formatting a disk completely erases any information stored on it, so make 
sure the disk you want to format doesn’t contain any information you may need.

2. Click the Start button and select My Computer.
The My Computer window appears.

3. Right-click the drive containing the disk you want to format (usually A:), and select 
Format from the shortcut menu.
The Format dialog box appears. There are several options you can specify when 
formatting a disk—see Figure 3-36 to see what they are.

4. Click Start.
The drive whirs as it formats the disk. Formatting a disk usually takes about a minute. 
When the format is complete, the Format Results dialog box appears with information 
about the formatted disk.
NOTE:  If the Format Results dialog box says your disk has bytes in bad sectors, throw 
it away. A disk with bad sectors is not reliable and should not be entrusted with your 
valuable data.

5. Click Close to close the Results dialog box, and click Close again to close the 
Format dialog box.

Figure 3-35
The Format 3½ 
Floppy dialog box

If you’re having problems 
with your computer, use 
a startup disk to help 
remedy your problems.

Formats the volume so 
that folders and files 
on it are compressed. 
Compression is supported 
only on NTFS drives.

Erases all information 
from the disk, but doesn’t 
scan the disk for damaged 
areas. Only works on 
disks that have previously 
been formatted.

	 QUICK REFERENCE
To Format a Disk:

Insert the disk you want to format into the drive.
Open My Computer, right-click the drive and select Format from the shortcut menu.
Select the formatting options and click Start.

1.
2.
3.
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Tutorial 3-17: Copying a Disk    
Instead of merely copying files and folders, someday you may find it necessary to make an 
exact copy of a disk. You should check two things before copying a disk. First, make sure 
the disks are the same density—most floppies are the High Density 1.44 MB type, so this 
shouldn’t be a problem. Secondly, make sure that the destination disk—the one where the 
information is being copied—doesn’t contain any information you may need, as the copy 
command will delete and replace any previously stored information with the information 
you are copying.

Unless you have a couple extra disks on hand, this isn’t a hands-on exercise. When you do 
need to copy a disk, however, here’s what to do:

1. Insert the original disk you want to copy into the drive.

2. Click the Start button and select My Computer from the menu.
The My Computer window appears. 

3. Right-click the drive containing the disk you want to copy (usually A:), and select 
Copy Disk from the shortcut menu.
The Copy Disk dialog box appears. Not many options are listed here—just select the 
drive you want the files copied from and where you want the files copied. Yes, you 
can choose the same drive as the disk you copy from.

4. Click Start. 
Another dialog box appears, asking you to confirm that the disk you want to copy 
from is inserted in the disk drive.

5. Click OK.
It will take about a minute for Windows to read all the information from the original 
source disk into your computer’s memory.

6. When prompted, insert the destination disk and click OK.
Depending on your computer’s configuration, Windows may ask you to swap the two 
disks several times to copy all the information from one disk to the other.
When the copy is finished, the dialog box displays a message: “Copy completed 
successfully.”

7. Click Close.

Figure 3-37
The Copy Disk 
dialog box

	 QUICK REFERENCE
To Copy a Disk:

Insert the source disk you want to copy into the disk drive.
Click the Start button and select My Computer from the menu.
Right-click the drive, and select Copy Disk from the shortcut menu.
Click Start.
Follow the on-screen instructions and insert the source and destination disk as prompted.

1.
2.
3.
4.
5.
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Chapter Three Review

Tutorial Summary
Repairing Disk Errors

To Use Error-checking: Click the Start button and select My Computer. Right-click the 
disk you want to scan, select Properties from the shortcut menu, and click the Tools 
tab. Click the Check Now button, specify disk options, and click Start.

Defragmenting Your Hard Disk
Click the Start button and select My Computer. Right-click the disk you want to 
defragment, select Properties from the shortcut menu, and click the Tools tab. Click 
the Defragment Now button, click Analyse button, and then click Defragment. Or, 
click the Start button and select All Programs → Accessories → System tools → 
Disk Defragmenter from the menu.

Freeing Up Space on Your Hard Disk
Click the Start button and select My Computer from the menu. Right-click the hard 
disk and select Properties from the shortcut menu. Or click the Start button and 
select All Programs → Accessories → System Tools → Disk Cleanup from the menu. 
Click the Disk Cleanup button and click OK. 
You can also free up hard disk space by removing programmes and Windows 
components that you don’t use.

Scheduling Tasks
The Task Scheduler automatically runs specified programmes when you tell it to.
To Schedule a Task: Click the Start button and select All Programs → Accessories → 
System Tools → Scheduled Tasks. Double-click the Add Scheduled Task icon, click 
Next, select the programme you want to schedule from the list, and click Next. Specify 
how often you want the programme to run and click Next. Select the time and day 
when you want the task to occur and click Next. Enter your user name and password 
information, click Next, and then click Finish.

Installing New Software
To Install Software Using the Control Panel: Find the programme’s disk (or disks) and 
insert it (or the first disk) into the disk drive. Click the Start button and select Control 
Panel. Click Add or Remove Programs. Click Add New Programs, click the CD or 
Floppy button, and then click Next. Follow the on-screen instructions to install the 
software automatically.
To Install Software Manually: Open My Computer, find the disk drive or folder where 
the programme you want to install is located, and find and double-click the installation 
programme (usually called SETUP or INSTALL). Follow the on-screen instructions to 
install the programme.

Removing Software
Click the Start button and select Control Panel. Click Add or Remove Programs. 
Click the Change or Remove Programs button, find and select the programme you 
want to remove from your computer, and click the Remove button. Finish removing 
the selected programme by following the on-screen instructions.

•

•

•

•

•
•

•

•

•
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Adding and Removing Windows Components
To Add or Remove Windows Components: Click the Start button and select Control 
Panel → Add or Remove Programs. Click the Add/Remove Windows Components 
button, and click the box beside the component category you want to add or remove. 
Click Next, then click Finish. 
To Add or Remove a Windows Component in a Category: Select the category, click 
Details, and then click the box beside the component category you want to add or 
remove. Click OK when you’re finished.

Installing a Printer
To Install a New Printer: If at all possible, install the printer using the included software 
and documentation. If you don’t have the software click the Start button and select 
Control Panel from the menu. Click the Printers and Other Hardware category and 
click the Add a printer task and click Next. Specify how the printer is connected (local 
or network) and click Next. Select a port to use with the printer and click Next. Select 
the printer’s manufacturer and model. If your printer doesn’t appear in the list, insert 
the disk that came with the printer and click the Have Disk button and click Next. 
Assign a name to the printer and set the printer as the default and click Next. Specify 
if the printer will be shared and click Next. Specify if you want a test page printed and 
click Next. Finally, click Finish.

Changing Printer Settings and the Default Printer
To Change the Default Printer: Click the Start button and select Control Panel from 
the menu. Click the Printers and Other Hardware category and click Printers and 
Faxes. Right-click the desired printer from the list and select Set as Default Printer 
from the shortcut menu.
To View/Change a Printer’s Default Properties: Right-click the appropriate printer, and 
select Properties from the shortcut menu.

Shutting Down a Frozen Programme
When a programme freezes or locks-up, you can close the programme by pressing 
<Ctrl> + <Alt> + <Delete>, selecting the programme, and clicking End Task.

Installing New Hardware
Most hardware devices are Plug and Play compliant, so Windows will automatically 
recognise and install them when you add them to your computer system. 
To Add New Hardware to Your Computer: Plug in the hardware device to your 
computer. Windows should automatically detect and install the device for you. If 
Windows doesn’t recognise the new hardware, click the Start button and select 
Control Panel from the menu. Click the Performance and Maintenance category and 
click System. Click the Hardware tab and click the Add Hardware Wizard button. 
Click Next and follow the on-screen instructions to have Windows search for your new 
hardware.

Using Automatic Updates
You must be connected to the Internet to run Automatic Updates.
To Run Automatic Updates: Click the Start button and select Control Panel from the 
menu. Click the Security Center category and click Automatic Updates. 

•

•

•

•

•

•

•

•

•
•
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Using Windows Update
Establish a connection to the Internet, then click the Start button and select All 
Programs → Windows Update from the menu. Click the type of install you want 
to perform. If you selected Express Install, click the Install button. If you selected 
Custom Install, click the check box next to the updates you want to install and then 
click Go to install updates to install them. 

Restoring Your Computer
To Restore your Computer: Click the Start button and select All Programs → 
Accessories → System Tools → System Restore from the menu. Make sure the 
Restore my computer to an earlier time option is selected and click Next. Select the 
restore point nearest to the time when your computer was working properly and click 
Next. Close all open files and programs and click Next. When the restore is complete 
the computer automatically restarts. Click OK to close the System Restore window.
To Create a Restore Point: Click the Start button and select All Programs → 
Accessories → System Tools → System Restore from the menu. Select Create a 
restore point, click Next, enter a name for your restore point and click Create. Close 
the System Restore window.

Using the Device Manager:
To Open the Device Manager: Click the Start button and select Control Panel from 
the menu. Click the Performance and Maintenance category and click System. Click 
the Hardware tab in the System Properties dialog box, and click the Device Manager 
button.
To View/Change a Device’s Properties: Right-click the device and select Properties 
from the shortcut menu.
To Remove a Device Driver: Select the device and click the Uninstall button. 

Be VERY CAREFUL when using the Device Manager! Don’t remove a hardware device or 
change its settings unless you know what you’re doing.

Formatting a Disk
Formatting disk erases any previous files stored on it and prepares the disk so that you 
can save information on it.
To Format a Floppy Disk: Insert the disk you want to format into the drive, open My 
Computer, right-click the drive, and select Format from the shortcut menu. Select the 
formatting options you want to use, and click Start.

Copying a Floppy Disk
To Copy a Floppy Disk: Insert the source disk you want to copy into the disk drive 
and click the Start button and select My Computer from the menu. Right-click the 
drive, and select Copy Disk from the shortcut menu. Click Start. Follow the on-screen 
instructions and insert the source and destination disk as prompted.

•

•

•

•

•

•

•
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MTC 116 – Electronic Office & The Windows Environment 
 

Please answer each question by clicking in the red check-box or boxes that you wish to select. 
For questions 5 and 24, type into the grey space provided, which will expand to accommodate your answer. 

 
 

1. You can move the taskbar to any edge of the screen – True of False? True  False  
 

2. Select all of the following statements which are true. 

 a. You can change the size of the taskbar by dragging its top edge until the taskbar is 
the size you want.  

 b. Move the pointer to the bottom of the screen to display a hidden taskbar.  

 c. You can position the taskbar so that it floats in the middle of the screen.  

 d. You can accidentally change the size of the taskbar so that it disappears almost 
completely from the screen – in which case you will need to resize it.  

 
3. Select all of the following statements which are NOT true. 

 a. You can’t add or remove programs from the Start menu.  

 b. Most programs add themselves to the Start menu’s All Programs menu.  

 c. Deleting a program from the Start menu deletes the program from your local disk.  

 d. 
You can open recently used documents by clicking the Start button, selecting My 
Recent Documents (Documents in Windows 2000), and selecting the file you want 
to open. 

 

 
4. Which of the following allow you to create, rename, delete, and move folders?  

 a. Windows Explorer.  

 b. WordPad.  

 c. Internet Explorer.  

 d. The Taskbar.  
 

5. You know a program is installed on your computer, but for some reason you can’t find it in the All 
Programs menu. Explain three of the ways in which you can you start the program. 

 a.       

 b.       

 c.       
 

6. Which of the following statements are NOT true? 

 a. Shortcuts have a  in the corner.  

 b. When you delete a shortcut, it also deletes the file or folder it points to.  

 c. You can create a shortcut by dragging the file or folder to a new location with the 
right mouse button and selecting Create Shortcut Here from the shortcut menu.  

 d. The items in the Start menu’s All Programs menu are actually shortcuts.  
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7. Used only for advanced networking settings, the Control Panel should 
never be touched by ordinary users – True or False? True  False  

 
8. Select all of the following statements which are true. 

 a. You can change the display style to Classic if you don’t like Windows 2000/XP 
style.  

 b. You can change the colours for all Windows objects at once using a colour 
scheme.  

 c. Double-click the clock on the taskbar to adjust the time and date.  

 d. You can only use preset patterns as your desktop wallpaper.  
 

10. From the following, select the ways in which you could customise your computer. 

 a. Change the desktop wallpaper.  

 b. Apply a desktop theme, which comes with Windows 2000/XP.  

 c. Add a system sound.  

 d. Windows 2000/XP doesn’t allow you to personalise your computer.  
 

12. 
Double-clicking the desktop opens the Display Properties dialog box, 
which allows you to change any screen settings, such as colours, 
screen resolution, and desktop wallpaper – True or False? 

True  False  

 

13. The Notepad program can open any text files of any size – True or 
False? True  False  

 
14. To record sounds with the Sound Recorder, select the options that you will need. 

 a. A sound card.  

 b. A microphone.  

 c. A MIDI interface.  

 d. Speakers.  
 

15. The Calculator program can be used for scientific modes – True or 
False? True  False  

 
16. Which of the following statements are true about Error-checking? 

 a. You can do a standard or thorough disk scan with Error-checking.  

 b. Error-checking can automatically repair most disk errors it finds.  

 c. Error-checking will find and remove any computer viruses it finds on your disk.  

 d. A thorough scan of a hard drive takes a long time—up to several hours.  
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17. By right-clicking your hard drive and selecting Properties, which of these programs can you 
access? 

 a. Error-checking.  

 b. Drive Converter (FAT32).  

 c. Disk Defragmenter.  

 d. Disk Cleanup.  
 

18. 
You’re a busy person and have better things to do than perform routine maintenance on your 
computer. What can you do to stop having to run Error-checking, Disk Clean-Up, and Disk 
Defragmenter each week? 

 a. Select Auto-run feature in the Disk Defragmenter program.  

 b. Don’t use your computer.  

 c. Add these programs to the Start-Up folder in the Programs menu.  

 d. Add these programs to the Task Scheduler.  
 

19. You have purchased a new program on CD. Which of the following will allow you to install it on 
your computer? 

 a. Insert the CD-ROM into the drive—Windows may automatically install it.  

 b. Insert the CD-ROM, open My Computer, look for a program file named “Setup”, 
“Install”, or something similar, and double-click it.  

 c. Right-click the taskbar, select Properties from the shortcut menu, click the Start 
Menu Programs tab, and click the Add button.  

 d. Open the Control Panel, double-click Add/Remove Programs, and click Install.  
 

20. Select all of the following statements which are true. 

 a. 
You can remove most programs on your computer by opening the Control Panel, 
clicking Add or Remove Programs, selecting the program you want to remove, and 
clicking the Remove button. 

 

 b. Everything included on the Windows 2000/XP CD-ROM is installed when you 
install Windows.  

 c. Pressing <Ctrl> + <Alt> + <Delete> opens the Close Program window, which you 
can use to forcefully end a program that has stopped responding.  

 d. The default printer is the printer Windows always uses unless you specify 
otherwise.  

 
21. Which of the following statements are true? 

 a. 
Computers have a limited amount of resources, which are used by hardware 
devices. If two hardware devices try to use the same resource, you have a 
hardware conflict. 

 

 b. Windows should automatically recognise and install any Plug and Play hardware 
devices that you’ve added when you first turn on the computer.  

 c. You can use the Add Hardware Wizard to install your hardware if Windows fails to 
recognise it.  

 d. Plug and Play devices get their name because you spend a lot of time playing 
around with them to get them to work.  
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22. From the following statements, select the difference between a workgroup and a domain. 

 a. A workgroup has centralised file and account maintenance. A domain is not 
centralised.  

 b. 
A workgroup is a network of computers that share resources, but does not have a 
presence on the Internet. A domain has identification on the Internet, called an IP 
address. 

 

 c. A workgroup is more common in organisations and businesses. A domain is more 
suitable for home users.  

 d. A workgroup is a peer-to-peer network. A domain is a client/server network.  
 

23. What kind of network is Windows XP Home configured for? 

 a. A domain.  

 b. A workgroup.  

 c. A client/server network.  

 d. It isn’t configured for a network. You must purchase networking software to create 
a network with Windows XP Home.  

 
24. Name three settings which are personalized in a user account? 

 a.       

 b.       

 c.       
 

25. When you create a user account on your domain computer, the user 
must already be part of the domain – True or False? True  False  

 
26. Select which of the following statements are true. 

 a. When you create a user account, you can limit the user’s access on the computer 
by choosing the account type.  

 b. You must be logged in to an administrator account to create a user account on a 
computer.  

 c. User accounts on Windows XP Home require a password.  

 d. User accounts on Windows XP Professional use the user name and password 
they use to log on to a domain.  

 

27. The Guest account in Windows XP Home gives unlimited access to 
individuals without an account on the computer – True or False? True  False  

 
28. Which of the following statements are true? 

 a. You can change the picture associated with an account in Windows XP 
Professional.  

 b. Changing your account password regularly helps keep your account secure.  

 c. You can change the picture associated with an account in Windows XP Home.  

 d. Only an administrator can change an account password.  
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29. Why should you log off your account when you’re finished using the computer? 

 a. Log off so the computer is ready for the next user.  

 b. Don’t log off, just shut down the computer.  

 c. Log off to prevent an unauthorised user from accessing your account or network.  

 d. All of the above.  
 

30. You can change how users log on or off their accounts in Windows XP 
Home by turning off the Welcome screen – True or False? True  False  

 
31. Which of the following are a required part of an Ethernet OR wireless network? 

 a. A network hub or switch.  

 b. A network administrator.  

 c. A network interface card (NIC).  

 d. An access point.  
 

32. What of the following might be wrong, if you are having trouble connecting to a wireless network?

 a. Your computer’s serial number does not match the network name.  

 b. Your WiFi card is not turned on.  

 c. Your WiFi card does not support the same wireless network standard as the 
network you are trying to connect to.  

 d. The WiFi signal strength is not strong enough.  
 

33. Which of the following are types of network components? 

 a. Clients.  

 b. Services.  

 c. Modems.  

 d. Protocols.  
 

34. TCP/IP is what holds the Internet together – True or False? True  False  
 

35. What are some of the advantages of an Ethernet network? 

 a. Because Ethernet has been around for quite some time, it is very reliable.  

 b. Ethernet cables are very convenient.  

 c. Because it doesn’t broadcast information via airwaves, Ethernet is extremely 
secure.  

 d. You can browse the Internet using hotspots found in most coffee shops.  
 

36. A large corporation would probably use a peer-to-peer network as its 
network – True or False? True  False  
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37. From the following, what are the benefits of networking? 

 a. A network allows you to share information, such as files and folders.  

 b. A network allows you to share equipment, such as printers.  

 c. A network allows you to use software designed for networks, such as e-mail and 
multi-user databases.  

 d. A network allows you to share electricity and conserve power.  
 

38. In a peer-to-peer network, everyone stores their files on their own 
computer – True or False? True  False  

 

39. You plug your new computer into the office network, double-click the My Network Places to 
browse the network, but there’s nothing there!  From the following select what could be wrong? 

 a. The Workgroup name in the Network dialog box is incorrect.  

 b. Your computer’s voltage output is too high.  

 c. Your computer doesn’t have the right network protocol installed.  

 d. Who cares? Give the network administrator a call—it’s their job to fix these kinds 
of problems!  

 

40. 
In order to change access permissions for a shared folder, you must be 
logged on to Windows XP with a user account that has administrative 
privileges – True or False? 

True  False  

 
41. Which of the following are examples of one of Outlook’s group collaboration features? 

 a. Merging several different folders from different Outlook users together into a 
single, grouped folder.  

 b. Opening another person’s folder.  

 c. Planning a meeting with other Outlook users.  

 d. Assigning a task to another user.  
 

42. 
When planning a meeting, if you add a person to the Required list, 
Outlook automatically assumes they will attend the meeting – True or 
False? 

True  False  
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43. You have been asked to manage a colleague’s Outlook calendar. Which of the following tasks do 
you need to complete in order to open your colleague’s calendar whenever you start Outlook? 

 a. Make sure you have permission to access your colleague’s entire Outlook 
account.  

 b. Make sure you have permission to access your colleague’s calendar folder.  

 c. 
Select File → Open → Other User’s Folder from the menu, click the Name 
button, find and double-click your colleague’s name, click the Folder arrow, select 
the name of the folder you want to view, select the Open Automatically option, and 
click OK. 

 

 d. 

Select Tools → E-Mail Accounts from the menu, select View or Change Existing 
E-Mail Accounts and click Next. Select Microsoft Exchange Server from the list, 
and click the Change button. Click the More Settings button and then click the 
Advanced tab, click the Add button, and type the name of your colleague in the 
following format: Last Name, First Name. 

 

 

44. 
You have been put in charge of organising a dance. Feeling under-motivated, you decide to give 
the various jobs associated with the dance to other colleagues. What is the best way of doing this 
using Outlook? 

 a. Secretly add the required tasks to your colleague’s Task Lists by opening their 
Task Lists folders.  

 b. 
Create a fake recurring appointment that shows everyone that you are busy from 
6:00 AM to 9:00 PM every day for the next 6 months and thus couldn’t possibly 
have enough time to work on the various tasks associated with the dance. 

 

 c. Use Outlook to plan a meeting with the colleagues where you can talk about the 
dance and hopefully give the various tasks over to someone else.  

 d. Add the required tasks for the dance to Outlook’s Task List and then assign them 
to other users.  

 
 
  




